
CP1484, CP1485, CP1486, CP3484, CP3485, CP3486
1.1  CP1484, CP1485, CP1486, CP3484, CP3485, CP3486

1.1.1  General information

Based on state-of-the-art Intel Celeron processor technology, the X20 CPUs cover a wide
spectrum of demands. They can be implemented in solutions ranging from standard applications
to those requiring the highest levels of performance.

USB and Ethernet are included in every CPU. Furthermore, every CPU has an ETHERNET
Powerlink connection for real-time communication.
In addition, there are up to three multi-purpose slots for additional interface modules.

• Intel Celeron 650/400/266 Performance

• Ethernet, ETHERNET Powerlink and USB onboard

• Modular expansion of interfaces

• Fan-free or exchangeable fan

• Extremely compact

1.1.2  Order data

Model number Short description

X20CP1484 X20 CPU, Celeron 266 comp., 32 MB DRAM, 1 MB SRAM, exchangeable application memory: 
CompactFlash, 1 insert slot for X20IF modules, 2 USB interfaces, 1 RS232 interface, 1 Ethernet 
interface 10/100 Base-T, 1 ETHERNET Powerlink interface, order program memory separately.

X20CP1485 X20 CPU, Celeron 400, 32 MB DRAM, 1 MB SRAM, exchangeable application memory: 
CompactFlash, 1 insert slot for X20IF modules, 2 USB interfaces, 1 RS232 interface, 1 Ethernet 
interface 10/100 Base-T, 1 ETHERNET Powerlink interface, order program memory separately.

X20CP1486 X20 CPU, Celeron 650, 64 MB DRAM, 1 MB SRAM, exchangeable application memory: 
CompactFlash, 1 insert slot for X20IF modules, 2 USB interfaces, 1 RS232 interface, 1 Ethernet 
interface 10/100 Base-T, 1 ETHERNET Powerlink interface, order program memory separately.

Table 1: X20 CPUs - order data

CP1484, CP1485, CP1486
1)

CP3484, CP3485, CP3486
1)
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CP1484, CP1485, CP1486, CP3484, CP3485, CP3486
1) Modules CP1486 and CP3486 have exchangeable fan

Model number Short description

X20CP3484 X20 CPU, Celeron 266 comp., 32 MB DRAM, 1 MB SRAM, exchangeable application memory: 
CompactFlash, 3 insert slots for X20IF modules, 2 USB interfaces, 1 RS232 interface, 1 Ethernet 
interface 10/100 Base-T, 1 ETHERNET Powerlink interface, order program memory separately.

X20CP3485 X20 CPU, Celeron 400, 32 MB DRAM, 1 MB SRAM, exchangeable application memory: 
CompactFlash, 3 insert slots for X20IF modules, 2 USB interfaces, 1 RS232 interface, 1 Ethernet 
interface 10/100 Base-T, 1 ETHERNET Powerlink interface, order program memory separately.

X20CP3486 X20 CPU, Celeron 650, 64 MB DRAM, 1 MB SRAM, exchangeable application memory: 
CompactFlash, 3 insert slots for X20IF modules, 2 USB interfaces, 1 RS232 interface, 1 Ethernet 
interface 10/100 Base-T, 1 ETHERNET Powerlink interface, order program memory separately.

Program memory

5CFCRD.0064-03 CompactFlash 64 MB TrueIDE SSI

5CFCRD.0128-03 CompactFlash 128 MB TrueIDE SSI

5CFCRD.0256-03 CompactFlash 256 MB TrueIDE SSI

5CFCRD.0512-03 CompactFlash 512 MB TrueIDE SSI

5CFCRD.1024-03 CompactFlash 1024 MB TrueIDE SSI

5CFCRD.2048-03 CompactFlash 2048 MB TrueIDE SSI

5CFCRD.4096-03 CompactFlash 4096 MB TrueIDE SSI

Included in delivery

4A0006.00-000 Backup battery (see also section 1.1.18 "Changing the lithium battery" on page 20)

- Interface module slot covers

X20AC0SR1 X20 locking plate (right)

X20TB12 Standard X20 terminal block (12-pin)

Table 1: X20 CPUs - order data
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CP1484, CP1485, CP1486, CP3484, CP3485, CP3486
1.1.3  Technical data

Product ID CP1484 CP3484 CP1485 CP3485 CP1486 CP3486

Short description

System module CPU

Processor Celeron 266 comp. Celeron 400 Celeron 650

Interfaces 1 x RS232, 1 x Ethernet, 1 x ETHERNET Powerlink, 2 x USB

Controller

Fastest task class cycle time 800 µs 400 µs 200 µs

Typical instruction cycle time TBD µs TBD µs TBD µs

Data and program code L1 cache 2 x 16 KB

L2 cache - 256 KB

Standard memory
RAM
User RAM

32 MB SDRAM
1 MB SRAM

64 MB SDRAM
1 MB SRAM

Remanent variables 64 KB 256 KB

FPU Yes

Integrated I/O processor Processes I/O data points in the background

Data buffering
Lithium battery
Battery monitoring

At least 3 years
Yes

CompactFlash slot 1

Real-time clock Nonvolatile memory, resolution 1 second

Modular interface slots 1 3 1 3 1 3

Interfaces

Interface IF1
Type
Type
Maximum transfer rate

RS232
On X20 standard terminal block

115.2 kBit/s

Interface IF2
Type
Type
Transfer rate
Cable length

Ethernet
Shielded RJ45 port

10/100 MBit/s
Max. 100 m between two stations (segment length)

Interface IF3
Fieldbus
Type
Type
Transfer rate
Cable length

ETHERNET Powerlink
100 Base-T (ANSI/IEEE 802.3)

Shielded RJ45 port
100 MBit/s

Max. 100 m between two stations (segment length)

Interfaces IF4 and IF5 USB Rev. 1.1

Table 2: X20 CPUs - technical data
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CP1484, CP1485, CP1486, CP3484, CP3485, CP3486
CPU and X2X Link supply

Input voltage 24 VDC (-15 % / +20 %)

Input current Max. 2.2 A

Reverse polarity protection Yes

Fuse Integrated, cannot be exchanged

X2X Link supply output

Rated output power 7.0 W

Parallel operation Yes 1) 

Redundant operation of 
X2X Link supply

Yes

I/O supply input

Input voltage 24 VDC (-15 % / +20 %)

Fuse Recommended pre-fusing max. 10 A slow-blow

I/O supply output

Rated output voltage 24 VDC

Allowable contact load 10.0 A

General supply

Status indicators Overload, operating status, module status

Diagnostics
Module run error
Overload

Yes, with status LED and software status
Yes, with status LED and software status

Electrical isolation
X2X bus supply
I/O supply

Yes
No

General information

Status indicators CPU function, overtemperature, Ethernet, ETHERNET Powerlink, CompactFlash, battery

Diagnostics
CPU function
Overtemperature
Ethernet
ETHERNET Powerlink
CompactFlash
Battery
Fans

Yes, with status LED
Yes, with status LED
Yes, with status LED
Yes, with status LED
Yes, with status LED

Yes, with status LED and software status
Yes, with software status

Visual Components capable Yes

ACOPOS™ capable Yes

Cooling Fan-free Fan-free with derating (see 
operational conditions)

Exchangeable fans for entire 
temperature range
Fan is monitored

Product ID CP1484 CP3484 CP1485 CP3485 CP1486 CP3486

Table 2: X20 CPUs - technical data (cont.)
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CP1484, CP1485, CP1486, CP3484, CP3485, CP3486
Electrical isolation
PLC - IF1/IF4/IF5
PLC - IF2/IF3
IF1/IF4/IF5 - IF2/IF3
IF1 - IF4/IF5
IF4 - IF5

No
Yes
Yes
No
No

Power consumption - without 
memory card, interface module 
or USB

10.5 W 10.5 W 10.5 W 10.5 W 13.5 W 13.5 W

Certification CE, C-UL-US (in development), GOST-R (in development)

Operational conditions

Operating temperature
Horizontal installation

Vertical installation

0 °C to +55 °C

0 °C to +50 °C

0 °C to +55 °C
Fan-free: 0 °C to +45 °C

0 °C to +55 °C,
Fan-free is not allowed

Humidity 5 to 95%, non-condensing

Mounting orientation Horizontal or vertical

Installation at altitudes 
above sea level

0 - 2000 m
>2000 m

No derating
Reduction of environmental temperature by 0.5 °C per 100 m

Protection type IP20

Storage and transport 
conditions

Temperature -25 °C to +70 °C

Humidity 5 to 95%, non-condensing

Mechanical characteristics

Dimensions (W x H x D) [mm] 150 x 99 x 85 200 x 99 x 85 150 x 99 x 85 200 x 99 x 85 150 x 99 x 85 200 x 99 x 85

Comment Order program memory (CompactFlash) separately
Backup battery included in delivery

X20 locking plate (right) included in delivery
Standard X20 terminal block (12-pin) included in delivery

Interface module slot covers included in delivery

1) In parallel operation, only 75 % of the rated power can be assumed. Please ensure that all parallel operating power supplies are
switched on and off simultaneously.

Product ID CP1484 CP3484 CP1485 CP3485 CP1486 CP3486

Table 2: X20 CPUs - technical data (cont.)
5Data sheet V 1.00



CP1484, CP1485, CP1486, CP3484, CP3485, CP3486
1.1.4  X20 CPUs - status LEDs

S/E LED

The Status/Error LED is a green/red dual LED. The status LEDs can have different meanings
depending on operating mode.

Ethernet TCP/IP mode

With Automation Studio™ Version V 2.5.3 and later, the interface can be operated as a purely
Ethernet TCP/IP interface.

LED Color Status Description

R/E Green On Application running

Red On SERVICE mode

RDY/F Yellow  On CPU is active

Red On Overtemperature

S/E Green/red Status/Error LED. The status of the LED is described in section "S/E LED".

EPL Green On A link to the ETHERNET Powerlink remote station has been established.

Blinking A link to the ETHERNET Powerlink remote station has been established. The LED 
blinks when Ethernet activity is present on the bus.

ETH Green On A link to the Ethernet remote station has been established.

Blinking A link to the Ethernet remote station has been established. The LED blinks when 
Ethernet activity is present on the bus.

CF Yellow  On CompactFlash OK

Green On CompactFlash active

DC OK Green On CPU power supply OK

Red On Backup battery is empty

Table 3: X20 CPUs - CPU status indicator

Green - status Description

On The ETHERNET Powerlink interface is operated as a pure TCP/IP interface.

Table 4: X20 CPUs status/error LED - Ethernet TCP/IP operating mode
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CP1484, CP1485, CP1486, CP3484, CP3485, CP3486
ETHERNET Powerlink V1

ETHERNET Powerlink V2

Status LED

Status of the Powerlink stationGreen Red

On Off The Powerlink station is running with no errors.

Off On A fatal system error has occurred. The error type can be read using the PLC logbook. It concerns an 
irreparable problem. The system cannot properly carry out its tasks. This status can only be changed 
by resetting the module.

Blinking alternately The Powerlink managing node failed. This error code can only occur in controlled node operation. This 
means that the set station number lies within the range $01 - $FD.

Off Blinking System failure. The red blinking LED signals an error code (see Section"System halt error codes", on 
page 9).

Table 5: X20 CPUs status/error LED - ETHERNET Powerlink V1 operating mode

Color red - error Description

On The ETHERNET Powerlink interface has encountered an error (failed Ethernet frames, burst of collisions on 
the network, etc.).

Table 6: X20 CPUs status/error LED as error LED - ETHERNET Powerlink V2 operating mode

Green - status Description

Off
NOT_ACTIVE

Managing Node (MN)
The bus is monitored for ETHERNET Powerlink frames. If no frame is received within the configured time 
window (timeout), the interface goes directly into PRE_OPERATIONAL_1 status (single flash).
If, however, ETHERNET Powerlink communication is detected during these 5s, the interface goes directly into 
the BASIC_ETHERNET status (flickering).

Controlled Node (CN)
The bus is monitored for ETHERNET Powerlink frames. If no frame is received within the configured time 
window (timeout), the interface goes directly into BASIC_ETHERNET status (flickering). If, however, 
ETHERNET Powerlink communication is detected during this time, the interface goes directly into the 
PRE_OPERATIONAL_1 status (single flash).

Blinking green (approx. 10 Hz)
BASIC_ETHERNET

The interface is in BASIC_ETHERNET status, and is operated as a pure TCP/IP interface.

Managing Node (MN)
This status can only be changed by resetting the interface.

Controlled Node (CN)
If an ETHERNET Powerlink communication is detected while in this status, the interface goes into the 
PRE_OPERATIONAL_1 state (single flash).

Table 7: X20 CPU status/error LED as status LED - ETHERNET Powerlink V2 operating mode
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CP1484, CP1485, CP1486, CP3484, CP3485, CP3486
Single flash (approx. 1 Hz)
PRE_OPERATIONAL_1

The interface status is PRE_OPERATIONAL_1.

Managing Node (MN)
The MN starts the operation of the "reduced cycle". Collisions are allowed on the bus. There is not yet any 
cyclic communication.

Controlled Node (CN)
The CN waits until it receives an SoC frame and then switches to PRE_OPERATIONAL_2 status (double 
flash).

Double flash (approx. 1 Hz)
PRE_OPERATIONAL_2

The interface status is PRE_OPERATIONAL_2.

Managing Node (MN)
The MN begins with the cyclic communication (cyclic input data are not yet evaluated). The CNs are configured 
in this status.

Controlled Node (CN)
In this status the interface is normally configured by the manager. After this, a command changes the status 
to READY_TO_OPERATE (triple flash).

Triple flash (approx. 1 Hz)

READY_TO_OPERATE

The interface status is READY_TO_OPERATE.

Managing Node (MN)

Normal cyclic and asynchronous communication. Received PDO data are ignored.

Controlled Node (CN)
The configuration of the interfaces is complete. Normal cyclic and asynchronous communication. The PDO 
data sent corresponds to the PDO mapping used. However, cyclic data is not yet evaluated.

On
OPERATIONAL

The interface status is OPERATIONAL.

Blinking (approx. 2.5 Hz)
STOPPED

The interface status is STOPPED.

Managing Node (MN)
This status is not possible for the MN.

Controlled Node (CN)
No output data are produced and no input data are received. Only the appropriate command from the manager 
can enter or leave this state.

Green - status Description

Table 7: X20 CPU status/error LED as status LED - ETHERNET Powerlink V2 operating mode
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CP1484, CP1485, CP1486, CP3484, CP3485, CP3486
System halt error codes

Incorrect configuration or defective hardware can cause a system halt error.

The error is displayed via the red error LED using four switch-on phases. The switch-on phases
are either 150 ms or 600 ms long. Error code outputs are repeated cyclically after 2 seconds has
passed.

Legend: • ... 150 ms
− ... 600 ms
Pause ... 2 s delay

Error description Error code displayed by red status LED

Stack overflow • • • • Pause • • • • Pause

RAM Error • • • − Pause • • • − Pause

Undefined address:
Access to a non-existent address

• • − • Pause • • − • Pause

Instruction fetch memory abort:

Invalid memory access during fetch instruction (e. g. UINT access of an uneven 
address).

• • − − Pause • • − − Pause

Data access memory abort:
Invalid memory access during data access (e. g. UINT access of an odd address).

• − • • Pause • − • • Pause

Error programming the FPGA • − − • Pause • − − • Pause

Invalid station number (e. g. $FE or $FF) • − − − Pause • − − − Pause

Table 8: X20 CPUs status/error LED as error LED - system halt error codes
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CP1484, CP1485, CP1486, CP3484, CP3485, CP3486
1.1.5  Status LEDs for integrated power supply

1.1.6  Operating and connection elements

CP1484, CP1485 and CP1486

Image LED Color Status Description

r Green Off Module not supplied

Single flash Reset mode

Blinking Preoperational mode

On RUN mode

e Red Off Module not supplied or everything is OK

Double flash Indicates one of the following conditions:
• X2X link power supply is overloaded

• I/O supply too low
• Input voltage for X2X Link supply too low

e + r Steady red / single green flash Invalid firmware

S Yellow  Off No RS232 activity

On The LED is on, when data is being sent or received via the RS232 
interface

I Red Off X2X link supply in the acceptable range

On X2X link power supply is overloaded

Table 9: X20 CPUs - status display for integrated power supply

Figure 1: X20 CPUs - operating elements for CP1484, CP1485, and CP1486

Mounting rail
latch

Operating mode
switch CompactFlash LED status indicators

IF1 - RS232
Exchangeable
fan (CP1486)

Ethernet
station address

IF2 -
IF3 -

Battery IF4 - USB
IF5 - USB

Slots for
interface
modules

Terminal block for CPU
and I/O feed,
RS232 connection

Ethernet
ETHERNET
Powerlink
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CP1484, CP1485, CP1486, CP3484, CP3485, CP3486
CP3484, CP3485, and CP3486

1.1.7  Slot for program memory

Program memory is required to operate the CPUs. The program memory is CompactFlash. It is
not included with the delivery of the CPUs, instead it must be ordered as an accessory.

Figure 2: X20 CPUs - operating elements for CP3484, CP3485, and CP3486

Mounting rail
latch

Operating mode
switch CompactFlash LED status indicators

IF1 - RS232
Exchangeable
fan (CP3486)

Ethernet
station address

IF2 -
IF3 -

IF4 - USB
IF5 - USB

Slots for
interface
modules

Terminal block for CPU
and I/O feed,
RS232 connection

Ethernet
ETHERNET
Powerlink

Battery
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CP1484, CP1485, CP1486, CP3484, CP3485, CP3486
1.1.8  Operating mode switch

An operating mode switch is used to set the operating mode.

Figure 3: X20 CPUs - operating mode switch

Switch position Operating mode Description

BOOT Boot In this switch position the default B&R Automation Runtime™ (AR) is started, and the runtime system 
can be installed using the online interface (B&R Automation Studio™). The User Flash is deleted after 
the download begins.

RUN Run RUN mode

DIAG Diagnostics The CPU boots in Diagnostics mode. Program sections in User RAM and User FlashPROM are not 
initialized. After Diagnostics mode, the CPU always boots with a warm restart.

Table 10: X20 CPUs - operating modes
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CP1484, CP1485, CP1486, CP3484, CP3485, CP3486
1.1.9  CPU supply

A power supply comes integrated in the X20 CPUs. It is equipped with a feed for the CPU, the
X2X Link, and the internal I/O supply. The feed to the CPU/X2X link supply is electrically isolated.

Redundancy of the X2X Link supply possible by parallel operation of multiple supply modules.

Pin assignments

Figure 4: X20 CPUs - pin assignments - integrated power supply

GND

+24 V I/O

+24 V I/O

GNDGND

+24 V CP/X2X L.

+24 V CP/X2X L.

GND

I

r e

S

Reserved

Reserved Reserved
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CP1484, CP1485, CP1486, CP3484, CP3485, CP3486
Connection examples

With two separate supplies

With a supply and jumper

Figure 5: X20 CPUs - connection example with two separate supplies

Figure 6: X20 CPUs - connection example with a supply and jumper

PS

GND

+24 VDC

+

_

I/O
supply

CP/X2X Link
supply

+

_

PS

GND

+24 VDC

+

_

I/O
supply

Jumper
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CP1484, CP1485, CP1486, CP3484, CP3485, CP3486
1.1.10  RS232 interface (IF1)

The RS232 interface is not electrically isolated. It can be used as an online interface for
communicating with the programming device.

Figure 7: X20 CPUs - pin assignments - RS232 interface (IF1)

I

r e

S

TX RX

GND
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CP1484, CP1485, CP1486, CP3484, CP3485, CP3486
1.1.11  Ethernet interface (IF2)

IF2 is an Ethernet interface. The connection is made using a 10/100 BASE-T Twisted Pair RJ45
socket.

The INA2000 station number for the Ethernet interface is set with the two hex switches.

Pin assignments

Figure 8: X20 CPUs - Ethernet interface (IF2)

Information:

The Ethernet interface (IF2) is not suited for ETHERNET Powerlink (see interface IF3
on page 17).

Pin Assignment

1 RXD Receive Data

2 RxD\ Receive Data\

3 TxD Transmit Data

4 Termination

5 Termination

6 TxD\ Transmit Data\

7 Termination

8 Termination

Table 11: X20 CPUs - pin assignments - Ethernet interface (IF2)
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CP1484, CP1485, CP1486, CP3484, CP3485, CP3486
1.1.12  ETHERNET Powerlink Interface (IF3)

The station number can be set using software. Station numbers are permitted between $00 and
$FD.

Switch position Description

$00 Operation as Managing Node (standard).

$01 - $FD Station number for Powerlink station. Operation as controlled node.

$FE Reserved, switch position is not permitted.

$FF Reserved, switch position is not permitted.

Table 12: X20 CPUs - ETHERNET Powerlink station number

Figure 9: X20 CPUs - ETHERNET Powerlink interface (IF3)

Pin Assignment

1 RXD Receive Data

2 RxD\ Receive Data\

3 TxD Transmit Data

4 Termination

5 Termination

6 TxD\ Transmit Data\

7 Termination

8 Termination

Table 13: X20 CPUs - pin assignments - ETHERNET Powerlink interface (IF3)
17Data sheet V 1.00



CP1484, CP1485, CP1486, CP3484, CP3485, CP3486
1.1.13  USB interfaces (IF4 and IF5)

IF4 and IF5 are USB interfaces. The connection is made using a USB 1.1 interface.

The USB interfaces can only be used for devices which have been released by B&R (e.g. floppy
disk drive, DiskOnKey or dongle).

1.1.14  Slots for interface modules

The CPUs are equipped with one or three slots for interface modules.

The X20 system can be connected to various bus or network systems by selecting the
appropriate interface modules.

Figure 10: X20 CPUs - USB interfaces (IF4 and IF5)

Information:

The USB interfaces cannot be used as online communication interfaces.
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CP1484, CP1485, CP1486, CP3484, CP3485, CP3486
1.1.15  Exchangeable fan

The CPUs do not require a fan. The Celeron 650 CPU can optionally be fitted with a fan. This
equips it for unrestricted use over the entire temperature range.

Changing the fan

1) Press in fan lock with thumb and pull out fan.

2) Insert new fan into CPU until the lock clicks into place.

1.1.16  Overtemperature shut-off

To prevent damage, a shut-off/reset is triggered when the CPU reaches 100 °C.

The following errors are entered in the log book:

Figure 11: X20 CPUs - tool-free fan replacement

Error number Error description

9204 WARNING: System halted because of temperature check

9210 WARNING: Boot by watchdog or manual reset

Table 14: X20 CPU log book entries for overtemperature shut-off
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CP1484, CP1485, CP1486, CP3484, CP3485, CP3486
1.1.17  Data / real-time buffering

The CPUs are equipped with a backup battery. The following areas are buffered:

• Remanent variables

• User RAM

• System RAM

• Real-time clock

Battery monitoring

The battery voltage is checked cyclically. The cyclic load test of the battery does not considerably
shorten the battery life, instead it gives an early warning of weakened buffer capacity.

The status information "Battery OK" is available from the system library function "BatteryInfo"
and the CPU's I/O mapping.

Battery change interval

The battery should be changed every 4 years. The change interval refers to the average life span
and operating conditions and is recommended by B&R. It is not the maximum buffer duration.

1.1.18  Changing the lithium battery

The CPUs are equipped with a lithium battery. The lithium battery is placed in a separate
compartment and protected by a cover.

Backup battery data

The product design allows the battery to be changed with the PLC switched either on or off. In
some countries, safety regulations do not allow batteries to be changed while the module is
switched on. To prevent data loss, the battery must be changed within 1 min. with the power off.

Model number
4A0006.00-000
0AC201.9

1 piece
5 pieces

Short description Lithium battery, 3 V / 950 mAh, button cell

Storage temperature -20 to +60 °C

Storage time Max. 3 years at 30°C

Humidity 0 to 95 % (non-condensing)

Table 15: X20 CPUs - backup battery data
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CP1484, CP1485, CP1486, CP3484, CP3485, CP3486
Procedure for changing the battery

1) Touch the mounting rail or ground connection (not the power supply!) in order to discharge
any electrostatic charge from your body.

2) Remove the cover for the lithium battery. To do this, slide the cover down from the CPU.

3) Remove the battery from the holder (do not use pliers or uninsulated tweezers -> risk of short
circuiting). The battery should not be held by its edges. Insulated tweezers may also be
used for removing the battery.

Figure 12: X20 CPUs - removing the cover for the lithium battery

Figure 13: X20 CPUs - correct grip for the battery

Like this: Not like this:
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CP1484, CP1485, CP1486, CP3484, CP3485, CP3486
4) Insert the new battery with correct polarity. To do this, the battery is laid with the "+" side up
on the right part of the battery holder under the USB interface IF4. Then secure the battery
in the holder by pressing above the left part of the battery holder.

5) Replace cover.

1.1.19  Programming the System Flash

General information

The CPUs are delivered with a default B&R Automation Runtime™ (with limited functions)
already installed. This runtime system is started in Boot mode (operating mode switch position
BOOT, no or invalid CompactFlash inserted). It initializes and operates the serial RS232 onboard
interface, allowing a runtime system download via INA2000 protocol.

This runtime system download is carried out during the commissioning of the CPU. The runtime
system is stored in the program memory (CompactFlash) of the processor. The runtime system
can be updated later by performing a runtime system update or using the B&R Automation
Studio PVI Transfer Tool.

X20 System CPUs are supported with B&R Automation Studio™ V 2.5.2.7 or later.

Runtime system download

When installing the runtime system (runtime system download) the following procedure must be
carried out:

1) Insert CompactFlash and switch on the power to the PLC. If the switch is in BOOT position,
or if a new or invalid CompactFlash card is inserted, the CPU is now in BOOT mode.

2) Establish an online connection between the programming device (PC or Industrial PC) and
the CPU. A runtime system download is only possible using the serial RS232 onboard
interface.

3) Start B&R Automation Studio™ programming environment.

4) Start the download procedure by selecting the Services command from the Project menu.
Select Transfer Operating System... from the menu shown. Now follow the instructions
from B&R Automation Studio™.

Information:
Lithium batteries are considered hazardous waste. Used batteries should be
disposed of accordingly.
22 Data sheet V 1.00



CP1484, CP1485, CP1486, CP3484, CP3485, CP3486
5) A dialog box is displayed for configuring the runtime system version. The runtime system
version is already preselected by the user's project settings. Using the drop-down menu, the
runtime system versions stored in the project can be selected. Clicking on the Browse button
allows the selected runtime system version to be loaded from the hard drive or from the CD.

Pressing Next > opens a pop-up window, which allows the user to select whether the
modules should be downloaded with SYSTEM ROM target memory using the following
runtime system download. Otherwise, modules can also be downloaded using a later
application download.

Pressing Next > brings the user to a control box where the current settings are displayed.

6) The download procedure is started by pressing Finish. Download progress is shown in a
message window.

7) To operate the runtime system, the operating mode switch must be turned to 4 when the
download procedure is completed. Reset the CPU or turn off and then on again if necessary.

8) The PLC is now ready for use.

Runtime system update

When updating the runtime system (online runtime system update), the following procedure
must be carried out:

1) An online runtime system update is only possible if a valid operating system is located on the
CompactFlash.

2) Establish an online connection between the programming device (PC or Industrial PC) and
the CPU. An online runtime update is now possible using the interfaces configured as an
online interface.
The runtime system update can be completed using either a serial online connection
(INA2000 protocol), a CAN network, or an ETHERNET network, depending on the system
configuration.

3) Start B&R Automation Studio™ programming environment.

4) Start the update procedure by calling the Services command from the Project menu. Select
Transfer Operating System... from the menu shown. Now follow the instructions from B&R
Automation Studio™.

Information:
The User Flash is cleared.
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5) A dialog box is displayed for configuring the runtime system version. The runtime system
version is already preselected by the user's project settings. Using the drop-down menu, the
runtime system versions stored in the project can be selected. Clicking on the Browse button
allows the selected runtime system version to be loaded from the hard drive or from the CD.

Pressing Next > opens a pop-up window, which allows the user to select whether the
modules should be downloaded with SYSTEM ROM target memory using the following
runtime system update. Otherwise, modules can also be downloaded using a later
application download.

Pressing Next > brings the user to a control box where the current settings are displayed.

6) The update procedure is started by pressing Finish. The update progress is shown in a
message box.

7) When the update procedure is complete, the online connection is automatically
reestablished.

8) The PLC is now ready for use.

Runtime system generation/update with the PVI Transfer Tool

1) In the Tools menu, select the command Generate transfer list.

2) In the dialog box that appears, select Generate complete transfer list and activate the
option Include operating system. Continue by clicking on OK.

3) In the Tools menu, select the command PVI Transfer Tool. This starts the PVI Transfer
Tool. For further steps, please refer to the Help for the PVI Transfer Tool (Tools - Create
CompactFlash).

Information:
The User Flash is cleared.
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